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If you have followed through the Tutorials (Power*Log Metric Tutorial followed by the Power*Curve
Metric Tutorial) we will now have to add the Type Well Curve data to the Tutorial Wells Data. If you have
not done the Tutorials you will skip ahead to page 7 to import the Power*Curve Tutorial Well. Before we
get started, we have to add the Type Well Curve to the previously done Power*Curve Tutorial Well.

Adding the Type Well Curve
Congratulations on completing the tutorials. If that is the case then you will have to add the Type Well
TVD Curve layer to this log and then import the Las file to get the Type Well GR Curve into your well

data.
#

PowerCurve

1.) Double click on the 1 lcon. Acknowledge the Security Information window by clicking on the
button. This will initiate the program and activate a Connect Database window.

Databases:

PGEOLOGY 2016 IMPERIAL [Microsoft Access T A
PHEOLOGY 2018 METRIC (Microsalt Aczess D

Lbger |0 !993'3'09.\-' Connect

xxxxxxxx
Paszward: Caricel

1.) Highlight the PGEOLOGY 2016 METRIC (Microsoft Access Driver[*.mbd])) database by clicking on it once.
2.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field.
Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field.

3.) Type “pgeology” in the Password field and then click on the button. The program will now load
various dictionaries and then activate an Open Log window.

Most Recently Opened Logs B s G
H Tutarial WWell Horz Log = earchwells by Field or

W Tutorial well Mate: Wildzards : % = any range, _ = singls character

o | Field

Choosze field to search

‘Wl Narme [ i [ SpudDate o =]
TN Tl el 100743206323w500 Jan 3. 2015 Erter Search Sting

i =i

- DLS [Domirion Land Survep Spstem]

Survey
System Loc Ex LSD Sec. Township Range EAwW ker 004 ES.

1 o

~MNTS [Mational Topographic Seres System]

Survey
SysternLoc, Ex. 144 Unit Block P, Quad L Ouad. Sizteenth E:S:.

> T TR T il TS TS TS il
#vailable Logs | Search | @ ByField (" ByDLS/NTS  Clear Quen |

| Cancel |

8.) Select the Tutorial Well from the List and then click on the button. This will open your
Tutorial Well Horz Log.
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9.) Under the Options menu, click on Log Configuration Builder or click on the H Log Configuration

Builder button on the Toolbar to activate the Log Configuration Builder window.

| - Available Logs -

L [ ] ! i
ng SYSTEM - (b Canta Log | Tutorial Well Horz Log | |

s ' Tracks Track Config. !
i Add Al >e» |

EﬁIZ E;ﬁ;i‘;cwe @ —l % 330 Detaled Lithology w

% 015 Slide - Rotate

" IBEEDt Shaw Al Y 0.20 Reservoir Quality

Ciifves ¥ 0.20 Rounding

Curve Fil Hide &1l ¥ 020 Sorting

Date Y 050 GrainSize

Depth Y 020 Interpreted Litholagy
Detaied Lithology Add >>>D * 0.50 Porosity Grade
Diagenesis H 015 Porosty Type

Diip Meter Data ST Y 015 0Oi S?ﬁw

Driiling Progress ] iy
| Friernn Channe o] [ c UL 55

ow/Hide
Track 'width: 12_ Log'width: ]8_ |

AM  Layers Laper Caonfig. l:

Dirill Fate (100143206323w500)

Gamma Fay (10014320632 3w500)
Curve Comments Total Gas (100714320632 2w500)
Engineering Parameters (100143205323, |
Mud Parameters  (1001432068322w500)

Gasz Annotations  [100143206323w/500)
Bit Record [(100743206323w500)

@ Layers
|

Exit

.

10.)On the left side of the Log configuration builder scroll down and highlight or click on the Curve track.

11.) Click on the Curve layer in the layers portion of the window on the lower left side of the builder to highlight it. In
addition, notice the Layers Radio button # on the left side is activated.

12.) On the right side (Active Log) of the Log Configuration Builder window, click on the Drilling Progress
track to highlight it. This is the track we want to add the Type Well Curve layer to.

13.) Click on the fd

button and you will be prompted with the following system message, “Do you want to

ADD the selected (layer) from the available log to the active log?” Click on the e button.

Mew Layer Name: iTPDB wiell Curve
o

14.) This will activate a Get Name window with “Type Well Curve” as the name in the New Layer Name field. Click

button and the Type Well Curve layer will then be added to the Drilling Progress track.

Available Logs - ~etive Log- -
E 3 ) ; =
|_Los. | [sveTEm e Log: [ Tutorialwell Horz Log
© Tracks e Track Config. ||
Core Rotosly AMARY || 350 Derated ek
Core Sample Code Sifse ihoinay: ~

v 015 Slide - Rotate
Lole tahlkeve Dale Show &l v 0.20 Reservoir Quality
¢ 020 Rounding

' 020 Soiting
el Grsin Gizs

v 050
‘v 0,20 Interpreted Lithology
v 050 Porosity Grade
M N 015 Porosiy Type
i v 015 il Show
Dilling Progress ﬂj ¥ 030 Depth1
Fremi Channe N | g
| ShawsHids

@ Layers
|

Track Widih: |2 Log'widh: |# ‘

& Layers Layer Corfig, ||

Tupe el Crve (10014320 L
Diill Rate [1007143206323w/500]

Gamma Ray [1007143206222w/500)
Total Gas [1007143206323w500]
Engineering Parameters (100142206323 |
Mud Parameters (100143206323 500)

Gas Anriotations  [100143206323w500]

Bit Record [100743206322/500])

Curve Comments

Exit S

Note: The Type Well Curve has not yet been associated with the Type Well Curve layer. This will be done when the
Add Curve window has been correctly filled in when you exit the Log Configuration Builder window.
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E it

15.) Click on the button to return to the log and the log will be initialized with the new layer, which in turn
will generate an Add Curve window.

The Add Curve window. o s Ea

1.) Type gapiin the Curve Units field. Ui/ 6F1 [100143206323w500

2.) Make sure mis in the Depth Units drop box field. -~ Cutve Heading

3.) Make sure the Null Value field is -999.25. Nome [TopeWelCuve  puoctnis Josni <)

4.) Make sure the Depth Interval is 0 and 0 indicating the Depth Units: [m =] NullValue: 99825000
present curve scale is applicable to any depth on the log. A

5.) Make sure the Curve Scale field values (Left / Bottom UseOtoOforthe wholelog] Lokt Battom] [Fight 4 Top)
and Right / Top) to 0 and 150 Depth 000 J000 CealelD o [150

6.) Make sure the Backup Scale drop box field is Straight Backup Scale: [Sraigtshit ¥ Gid Type: OB

Shift. —— I

7.) Make sure the Grid type drop box field is Linear.

8.) Click on the L d button to add the Type Well Curve layer to the Drilling Progress Track.
Importing the LAS Type Well Curve
1. Click on the File pull down menu selection and click on Import and then click on LAS from the pop

out-menu or simply click on the s LAS button, on the Import Toolbar, to activate the LAS Reader
window.

File | Edit View Reports Options Windc

Disconnect

Access Registration ’ Losicin: | | SYSTEM _"_! - Ef( v

New Crl+N

Open.. -0 Mame Date modified

Close

g ~ s = Imperial Horizontal Gamma Ray Curve.las 8/30/2012 11:55 PM

| Bxport ’ Ascll .: Metric Core Rate Curve.las 871772012 3:06 PM

ke E:: ::ZM .g Metric Core Tutorial gamma ray curve.las 9/26/2006 4:26 PM

Print Log... Ctrl+P =

Peintto :—WF Dip Meter E, Metric Horizontal Gamma Ray Curve.las 4730/2012 3:38 PM

print Morning epor.. i i § | PowerSteer Gamma Ray type well,ias A/572016 1232 PM o

Print Well End Repart... I il

Print Reports to Word® Loyt Wel.. < >

Print Setup... il

= Percarti () Fle name:  |PowerSteer Gamma Ray typs welllas Cpen I
Perforations

Survey Viewer S =

Core Photo Profile Tool :nu: R::: Files of type: I LAS (*las} _:J Cancel )
Surveys.. ' a8

2. This will then activate the Open window which allows the user to select the LAS file you wish to
import the data from. You can find the file in the PowerSuite_2016\System\PowerSteer Gamma Ray

type well.las and highlight the file by clicking on it once and then click on the button. You
will see the window shown below. It will default to the importing of Curve data.
3. Onthe lower left side of the window Click and drag the Type Well curve to the Type Well Curve
layer on the lower right side and release it when the layer name becomes highlighted.
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File View Help
ZEsE ?|
-L#5 PowerSteer Gamma Ray type | DEPT Type Well A
version 12224595 574833
well 1222.6695 57.5926
o 12228655 57.7216
o 1223.06%% 574779
1223.2695 56,2628
12234899 56.2483
12236695 55,3634
12238695 55,6786
1224.0655 56,5786
1224.2695 58,6495
12244899 60,7069 9
~
Chioose Data Type; [CUves -
Cuive Depth Column; PEPT =
Click and Drag with the Left Mouss button. Drag the columnis of the data file over to the conesponding field W Append Data Ta Curve
Name [ Desc | Units. Top | Curve Layer ID | Esisting I | Mapped ID | Action
CIBDEPT 1 Depths amin Measursd Dept.. M Proposed Wel F... Proposed Well P Append
1222 4693
E e wial GAFI B8 wel Path(S5] Wl Path (S5) Append
Base BE wiel Path (TVD) Wl Path [TVD) Append
2436.9693 |34 Diil Rate Diil Fate Append
. Gama Aay Gamma Flay Append
slep B 1okl s Tolal Gas Append
0.2 38 Tope Well Cuve  Type'Wel Curve.  Typs Wel  Append
[mport
L £ > v
Tutorial Well Horz Log C [NuM | v |

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from
append to replace. The Symbol color will either be purple for replace or blue for append.

4. Click on the M button. You will then be prompted with a system message after the import has
finished.

Import Curves
4‘) Finished Import

5. Acknowledge the Finished Import message. Click on the button and then click on the
button to exit or click on the File menu and select the Exit option to close the LAS Reader Window.

Removing the Type Well Curve Layer from the Tutorial Well HZ log.
This does not delete the type well curve but removes it from the log display.

1.) Under the Options menu, click on Log Configuration Builder or click on the H Log Configuration
Builder button on the Toolbar to activate the Log Configuration Builder window.

| - Lvailable o

|ty [T = :
Ll =2¥5IEM = Lag Canfig.

Log: ITutoriaI Well Horz Log _'j

@ Tracks " Tracks Track Config. i
Add Al e
—| Y 330 Detailed Lithology ~
% 015 Slide - Ratate
Show &l | ¥ 0.20 Reservoir Quality

Y 0.20 Rounding
Auto Test Interval Calcualtor
Bedding Contacts Hide &l | ¥ 020 Sorting
bt Y 050 GrainSize
Bit Recards Y 020 Interpreted Lithiolagy
EE e e Add s | 050 Porosity Grade
Cadiba 15 Porosity Type

15 Oil Show

Core

Core Bow Data Delete E |
| IPoes Piandit ¥
[ ShowHide |

| Track Width: 12 Log'width [
M & Layers Laper Canfig, I

‘ i Layers
Drill R ate [100143206323w500)
Gamma Flay [100143206322w500)
Total Gaz (10014320632 3w500)

Engineering Parameters (100143206323
Mud Parameters  [100143206323/500)
Gas Annotations  [100143206323wW500]
Bit Record (10014320632 3/500]

Exit
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2.) Onthe right side of the Log configuration builder scroll down and highlight or click on the Drilling
Progress track.

3.) Click on the Type Well Curve layer in the layers portion of the window on the lower right side of the builder to
highlight it. In addition, notice the Layers Radio button # on the left side is activated.

4.) Click on the ﬂ button and you will be prompted with the following system message.
Power'log Ea

Iel Do you want to DELETE the selected <LAYER> in the active log?

Yes L\‘!J Neo I

Note: The Type Well Curve data will not be deleted from the database. You are just deleting a layer that shows the
Type Well Curve data from the Tutorial Well HZ log.

5.) Click on the — " | putton.
6.) Click on the Ealt

Power*Steer
Now we will start up the Power*Steer Portion of this Tutorial.

button to return to the log and the log will be initialized with this layer now deleted.

Connecting to the Database

ALE

owerSteer

P
1.) Double click on the Power*Steer 15 Icon. This will initiate the program and activate a Connect

Database window. _ _
| Connect Database

Databazes:

PGE OLOGY 2016 IMPERIAL (M

E icrosaft &coes
PEEOLOGY 2018 METRIC {Micmo:

sC o

£

User 10 {poeology Cannect

R
Passgword: | Cancel

4.) Highlight the PGEOLOGY 2016 METRIC (Microsoft Access Driver[*.mbd])) database by clicking on it
once.

5.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the
User ID field. Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to
the Password field.

6.) Type “pgeology” in the Password field and then click on the button. The program will now
load various dictionaries and then activate a Well List window.

Import Log / Well Data.

If you have followed all the tutorials you can skip ahead to page 10. If you have not done the Metric

Power*Log Tutorial followed by the Metric Power*Curve Tutorial you will have no data available to you

to do this Power*Steer tutorial. We will make this easy and have you import the Metric Tutorial

Horizontal Well. This will have the majority of the data all the data you need. If you have followed along

with the tutorials skip ahead to page .

Power*Steer Tutorial Page 7
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1. Select Import under the File menu selection, and then select Log/Well from the sub-menu. This will
activate the Import window.

| [ Fies. | o to Export
Time of Expot | Fie ame & | Nene
- - . . . 2015/01/01 - - B Delete Files
| File | Edit View Help Window

Open Cirl+D Exclude Files

Close Start Eport

Refresh Data File Header:

: Tirme of Export 201601091210 -
Background Graphic 2 Product: POWER'SUITE
: | Version 2016.0.0.0
Import 3 Log/ Well Descriptior: horz
1 Log, Tutorial Wel Horz Log
v = il Name: Tutorial Wel

Export | Zones/Tops U/1: 100143206323w/500

pp Ver: 2016,0,0,0
: Storage Units: Melric

Print... Ctrl=P [EXPORT OPTIONS]

&ty Log Configuration; Yes

FrnLFreview Eritire: Wwiell fes

- Today's Interval No

Print Setup.., 0,00 to 0.00
Maming Frepoit
Interyal:

Exit Interval Data ” Evit

2.) Click onthe 7| button. This will activate the Import from window and now you will have to
browse to find the folder C:\POWERSUITE_2016\SYSTEM and then the file name you want to
import is Metric Tutorial Horizontal Log.exp.

Lockin: | 1l SYSTEM

Name
NTDriver
| Imperial Vertical Tutorial Well.exp
|| Metric Tutorial Core Log Facies Well.exp

x| & B ok Er

Date modified

2/18/2016 9:37 AM
1/28/2015 430 PM
§/14/2015 G:45 AM

-

Metric Tutorial Horizontal Log.exp

1/20/2015 10:15 AM

|| Metric Tutorial Vertical Well.exp

1/20/2015 18:15AM &

£ 2
File mame:  [Metric Tutorial Horizontal Log &xp Open |
Fies of type: | Export files [“exn) ~] Cancel J

Note that files available for importing will have an .EXP file extension. Any of the files that you select will
then be added to the File list. Please make sure that the files you wish to import are highlighted
(selected), in the list prior to importing.

3.) Highlight the file name and click on the %=1 |putton.
4.) The Import Log/Well window will now be displayed with the details of the file to be imported.
Select/highlight the file to be imported.

Click on the —®™™" 'hutton to activate the following system message, “Do you really want to
IMPORT the highlighted files?”

Click onthe  **

5.)

6.) button to proceed with the import.

Note: If you click on the “Yes” button, and the file you are importing contains the information from an
Entire Well, the following system message will be activated, “About to IMPORT ENTIRE WELL data. All
information associated with this well in the database will be OVERWRITTEN. Continue?”

Yes

7.) Click on the button.
8.) Upon completion of the import, the following system message will then be activated, “Data has
been imported successfully.”

9.) Click on the button to confirm the successful import of the data.

10.)Close the Data Transfer window by clicking on the _ e | button or by clicking on the ﬂ icon
located at the top right of the Data Transfer window.

Power*Steer Tutorial Page 8
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&Y

1001401051 1 Sw/S00
10003360501 JwS00
007141501 223500
1001 43206123500

[ o] o |
7.) Double Click on the Tutorial Well or Highlight the Tutorial well and then click on the
button. Because this is the first time the Tutorial Well has been opened it will be a blank template
starting at zero depths with no scales.

If you have not done the Power*Log and or Power*Curve tutorials this Well will not be in the list. Then
we must import The Tutorial Well. If you have done the tutorials then skip ahead to page 11 Set Well
path.

Refresh Data [File| Edit View Window Help
If the well was opened and you have imported a newer file the Power*Steer | S::E B
application must be refreshed to see the new data that has been imported. | Refrech Data N
Because we did not have the well opened at this time you would not have to ls“"g:'””d i ¢
mpo »
do this step. To refresh the data you would. Export .
Print... Ctrl+P
1.) Click on the File Menu to activate the drop down list and Click on the Print Preview
Refresh Data Selection to refresh the well’s data you have open in R
Power*Steer. s
Open Well

Now you have imported the Tutorial Well we now have to open the well.

1.) Click on the File Menu to activate the drop down list and click on the Open Selection to activate the
Well List.

Power*Steer Tutorial Page 9
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Recently Opened

Hame | Liwil
Tutarial ‘el 101 43206323500

£

Choose a wel

Nams = | Lhwtl

1001 4320632/500

! File | View Help

| Open [%_Cfrh 0 |
Print Setup... ] =
Exit O[] cemcel | |

2.) Select the Tutorial Well by double clicking on the well name or highlighting once and click on the
button.

This will open the Power*Steer with 2 panes and no data shown with the depths defaulted to zero (0).

MD Cune 0. 1S 25T D Lk vaue 4 0 D" £107 s 000 S 30000 040
e e e e ey

Power*Steer Well data needed from Power*Log / Power*Curve.

A Well Path (TVD units) Curve has to be added and then calculated from the survey data.
Survey data must also be up to date to display the information on the Power*Steer application.
A measured depth Gamma Ray Curve must exist for the well being steered.

A Type Well Gamma Ray Curve (TVD {True Vertical Depth}/ RSD {Relative Stratagraphic Depth})
must exist for the well to be steered.

Zone of interest must be known and identified on the Type well.

Formation Tops may be added and also have to have the thickness calculated in order to show
up in the list to be drawn in Power*Steer.

Set Well Path

1.
2.

Right click on the Well Path pane (right side) to activate the pop out menu
Select Set Well Path. This will activate a Select Curve Window.

Power*Steer Tutorial Page 10
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Add Segment
Delete Segment
Change Azimuth

|

 SetWell Path N |
Set Gamma ‘
Overlay Curves

Segment Properties

General Prapertiﬂ 1"‘."\"‘8" Path [Tl"."ID] or
Show/Hide Tops
Show/Hide Zones
Show/Hide Perforations

Show/Hide Zone Fill

Cancel | T |

3. Select the steered Well Path Curve in TVD units from the drop down list by clicking on the down

arrow and selecting it from your curve list for this well from your database.
4. Click on the button.

Set the Gamma Curve

1. Right click on the Well Path pane (right side) to activate the pop out menu
2. Select Set Gamma. This will activate a Select Curve Window.

Add Segment
Delete Segment
Change Azimuth

Set Well Path |
Set Gamma L} |
Overlay Curves

Segment Properties

General Properties
Show/Hide Tops
Show/Hide Zones
Show/Hide Perforations
| Show/Hide Zone Fill |

3. Select the steered wells Gamma Ray curve in measured depth units from the drop down list by
clicking on the down arrow and selecting it from your curve list for this well from your
database.

Note: This Gamma Ray curve will be displayed on the lower portion of the well path and will either be
displayed in MD or VS depth units depending on the view. This is the curve that you will be attempting
to correlate to the Type Well Curve. It doesn’t necessarily have to be the Gamma Curve but this tool is
by far the most common tools to be run downhole while drilling.

4. Click on the button.

Set the Overlay Curves

If the user wishes to have more curves displayed on the Segment portion of the window the user can
also display those curves in either MD or vertical section depth display. These are only for display
purposes and will not be used to correlate to the Type Wells data.

1. Right click on the Well Path pane (right side) to activate the pop out menu
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2. Select Overlay Curves. This will activate an Overlay Curves list.

Add Segment
Delete Segment
Change Azimuth r]l: Fiat
[ 1Core Rate
:E"":d’ fetl [ 1Dl Rate
et
= .;'.'“g"_a = [ 1Gamma R ay
erlay Curves |
Segment Properties lb PerDS E" Fa [TvD]

General Properties
Show/Hide Tops
Show/Hide Zones

0
Show/Hide Perforations Cancel

Show/Hide Zone Fill

3. Select the Total Gas curve from the list and you may display other curves captured in your wells
database. Display these curves data by activating the check box beside the curves.

Note: These Overlay curves will be displayed on the lower portion of the well path and will either be
displayed in MD or VS depth units depending on the view. These curves are for display purposes only.

4. Click on the button.

Set Type Well Curve
1. Right click on the Type Well portion of the screen (left side)
2. Select Set Type Well Curve from the pop out menu list. This will activate a Select Curve list.

| S .‘-pre-in\ret-}"auwe — [} :
Mapped Offset
Add Segment
Set Reference Point
Edit Reference Offset
Delete Reference Point I:I:!re Fate
Dol R ate
Add Zone
Gamma Fay
Delete Zone | Propozed Well Path [TWD)
Show Al ':'al G .
[ = AT =
General Properties SHE S

3. Select the Type Well Curve that you will be steering to. This is Type Well GR curve you imported
into your steered well in Power*Curve.

4. Click on the button.

Type Well Depth Manipulation
yp p p [m Help  Window

Go To Depth (Type Well) | Measured Depth View
1. Click on the Type Well Portion of the window. 08| | Toolbat
2. Click on the View Menu to activate the drop down list. - :
3. Click on Go To Depth (Type Well) selection to activate the Goto | f‘*: ge::: ”:’P:::;:? N
Window. :
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4. Type a 2395 in the Type Well Depth Field. FE =
5. Click on the II' button. This will change the depth view fromO0to | | _\.ipem '
2395 at the top of the type well. f2335
Ok I Cancel ‘

Type Well Track Depth Scrolling
Once the Type Well curve has been added to this track the user has the ability to scroll up and down the

curve depth display. _ —
Mouse Pointer Controls P i

The user can click on the up / down arrows on the right side of the
track pane to move up or down a bit or click on the space between
the thumb and arrows to move up or down 1/4 page.

Mouse Roller Ball Control
Click on the Type Well pane and then roll the roller ball away from
you to scroll up the view.

Click on the Type Well pane and then roll the roller ball towards you P || -
to scroll down the view. ved & oo

Type Well Display Scale Manipulation

Click on the Type Well pane, hold the CTRL Key down on the keypad
and then roll the roller ball away from you to decrease the scale so
that you can see less data in the Type Well.

Click on the Type Well pane, hold the CTRL Key down on the keypad and then roll the roller ball
towards you to increase the scale so that you can see more data in the Type Well.

V’rei Help  Window

GoTo Depth (Well Path) | Measured Depth View

1. Click on the Well Path Portion of the window. }: ;’a‘:'u“éar

2. Click on the View Menu to activate the drop down list. =

3. Click on Go To Depth (Well Path) selection to activate the Goto Window. | Gnm :,E'p,(h (\T,\r;”pat:, N '

4. Type a 200 in the Well Path Depth Field. e Ea

5. Click on the II' button. | ‘\wel Path Depth '
200

Well Path MD/VS Gamma Ray Depth Scale Display Manipulation ;T| Cancel |

Click on the Well Path pane, hold the CTRL Key down on the keypad and then
roll the roller ball away from you to decrease the scale so that you can see less data in the Well Path
and MD / VS Gamma Ray.

Click on the Well Path pane, hold the CTRL Key down on the keypad and then roll the roller ball
towards you to increase the scale so that you can see more data in the Well Path and MD / VS Gamma
Ray.
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Well Path (Vertical Section) t} Click here to move
up a small amount
the TVD well path
scale, this will
move path the top
and bottom of the
scale

Click here to move
%uo a larger ameunt
the TVD well path
scale, this will
move path the top

and bottom of the
scale.

Thumb has been
disabled

1000 1100 1200 1300 1400 1500 1600 1700 1800 1800 Click here to move
down a larger
amount the TVD
well path scale, this
will move path the
top and bottom of
the scale.

Click here to move
down & small
164 F 038 amount the TVD

200 300 400 500 800 700 800 900 1000 1100 1200 1300 1400 1500 1600 1700 1800 1900 well path scale
this will move path
& [ [ o j}, the top and bottorn
| [NUM | of the scale
Click here to scroll the log click here to scroll the log back a 1/4 Thumb has been disabled Click here to scroll the log Click here to scroll the Iog ahead
back a few meters page Forward a 1/4 page a few meters

Well Path TVD Scale manipulation

Mouse Pointer Controls

The user can click on the up / down arrows on the right side of the track pane to move up or down a bit
or click on the space between the thumb and arrows to move up or down 1/4 page. This will move all
the scales (both top and bottom scales simultaneously).

Mouse Roller Ball Control
Click on the Well Path pane, hold the Shift Key down on the keypad and then roll the roller ball
towards you will move the TVD scale down (both top and bottom scales simultaneously).

Click on the Well Path pane, hold the Shift Key down on the keypad and then roll the roller ball away
from you will move the TVD scale up (both top and bottom scales simultaneously).

Click and drag up on the Well Path portion of the pane to see a more detailed view or less TVD range.
This action will not move the bottom TVD scale.

Click and drag down on the Well Path portion of the pane to see a less detailed view or more TVD range.
This action will not move the bottom TVD scale.

Well Path MD/VS Gamma Ray Depth Manipulation

Once the Well Path TVD curve, Measured Depth Gamma Ray curve has been added to these track the
user has the ability to scroll left and right to change the curve depth display.
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Mouse Pointer Controls
The user can click on the left / right arrows on the bottom side of the track pane to move left or right a
bit or click on the space between the thumb and arrows to go left or right 1/4 page.

Mouse Roller Ball Control
Click on the Well Path pane and then roll the roller ball away from you to scroll left or back.

Click on the Well Path pane and then roll the roller ball towards you to scroll right or forward.

Curve Display and Grid Pattern Manipulation
1. Right Click anywhere in either pane to activate the pop out menu.
2. Select General Properties. This will activate the General Properties window.

T | Add Segment
Set Type Well Curve Delete Segment Curve Settings | Forrnaﬁons! Zores |Screen Format ]
hikipped Otiset Change Azimuth | -] ™ lanore NULL
Add Segment -
i Set Well Path ~Display Scale
Set Reference Point Al [ - R In
Edit Reference Offset ! 1
Owerlay Curves Right/Top- ]
Delete Reference Point Segment Properties bt Siaa! i1 Grid
| General P rti |
Add Zone |l eral _ roperties m e in i F_
Delete Zone Show/Hide Tops . ]1_.
Show/Hide Zones S
Show }_5‘” - : Show/Hide Pedforations
| General Properties | Shiow/Hide Zone Fill

Right Click Type Well Pane Right Click Well path Pane
3. The default Tab selection is the Curve Setting tab. So now Click on the drop arrow and select the
Type Well curve to change the display for.

Curve Settings ] Formations | Zones | Screen Format ]

IT)'pe Well Li ¥ Ignore NULL
1~ Display Scale
[a]) - Lt/ [0
Right,/ Top: ]15{}
Line Size: i1 |- Grid
Line Style: lD Major IE’
Inc: i

4. Line Size portion of the window will change the line thickness from 1 to 20 (pixels wide). You
have to type a number in the size field and your input will be automatically displayed by the
curve.

5. Line Style portion of the window will change the line style. You have to type a number in the
style field from 0 to 3 and your input will be automatically displayed by the curve. 0=Solid line,
1=Dashed Line, 2=Dotted Line, 3=Dash Dot Line
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6. Scale Portion of window allows the user to change scales for the selected curve. Type a value in
the appropriate fields to change the scales. The scales will change as you type.

7. Grid Portion of window allows the user to change the grid pattern for the selected curve. Type a
value in the appropriate fields to change the grids. The grids will change as you type. Major
Grids will indicate a value. The minor grids will divide the whole track and not the majors.

8. Ignore NULL’s check box when activated will join curve values ignoring the null values. When
deactivated the curve will only draw when there are two consecutive data points.

9. Repeat Steps 6-8 to change the appearance of the other curves presented in Power*Steer.

10. Click on the in the upper right hand corner to exit this window.

Adding Zones

We will now add some Zones to the Type Well. They could be formation tops or other indicators that
you wish to mark on your Type Well and will be transposed and manipulated by your segment
movements in the Well Path pane.

1. Right Click at 2405.5 on your Type Well pane to activate the pop out menu.
2. Select Add Zone from the pop out menu list. This will activate the Add Label window.

Set Type Well Curve

Mapped Offset ﬁ;ﬂ;ﬂ[ﬂh& n

Add Segment
Set Reference Point
Edit Reference Offset | Red Sky

Delete Reference Point -
" Top O Base

Add Zone %

Delete Zone

Show Al Cancel ‘ o, |

General Properties

3. Typein a Red Sky in the field provided.
4. Click on the [_%_Ibutton. This will close the window and add the Red Sky Zone Label to the Type
Well pane.

Note: The label will only be seen on the Well Path Pane after you have added a Reference Point

5. Right Click at 2409.8 on your Type Well pane to activate the pop out menu.
6. Select Add Zone from the pop out menu list. This will activate the Add Label window.

Set Type Well Curve
M d Offset S AT

e Add La
Add Segment
Set Reference Point |
Edit Reference Offset |HE':| Sky Main Sand

Delete Reference Point - T oo B o
u]
Add Zone % R

Delete Zone

Show Al Cancel ‘ o, |

General Properties

7. Type in a Red Sky Main Sand in the field provided.
8. Click on the [_%_Tbutton. This will close the window and add the Red Sky Main Sand Zone Label to
both the Type Well pane.
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9.

Right Click at the 2429 on your Type Well pane to activate the pop out menu.

10. Select Add Zone from the pop out menu list. This will activate the Add Label window.

11.

12.
13.

14.
15.

16.

17.
18.

19.
20.

Set Type Well Curve
Mapped Offset ﬁﬂﬂ"lﬁbﬂi “
Add Segment

Set Reference Point
Edit Reference Offset |z|:|| [T DF']

Delete Reference Point = -
+ Top O Base

Add Zone %

Delete Zone

Show Al Cancel ‘ o, |

General Properties

Type in a ZOI (Top) {ZOl is an acronym for Zone of Interest} in the field provided.

This is a zone marker that indicates that you are inside the designated target and you would like to
calculate the percentage of the well’s path that is inside the target boundaries then you must
indicate whether this label is the top or base of the Zone. The user can only have one label
designated at top and one zone label that is designated as base.

This is the primary target label indicator then you must click on the ® Ter T a2 pytton.

Click on the [_%__| button. This will close the window and add the ZOI (Top) label to the Type Well
pane.

Right Click at the 2430.5 on your Type Well pane to activate the pop out menu.

Select Add Zone from the pop out menu list. This will activate the Add Label window.

Set Type Well Curve

Add Segment

Set Reference Point

Edit Reference Offset |2|:|| [B EISE]

Delete Reference Point o e oy Ease

Add Zone % R

Delete Zone

Show Al Canhcel ‘ (1] 4 [

General Properties

Type in a ZOI (Base) {ZOl is an acronym for Zone of Interest} in the field provided.

This is a zone marker that indicates that you are inside the designated target and you would like to
calculate the percentage of the well’s path that is inside the target boundaries then you must
indicate whether this label is the top or base of the Zone. The user can only have one label
designated at top and one zone label that is designated as base.

This is a primary target label indicator then you must click on the © Tap  © Base pbuseon,
Click on the [__%__|button. This will close the window and add the ZOI (Base) to the Type Well
pane.

Right Click at 2435.5 on your Type Well pane to activate the pop out menu.

Select Add Zone from the pop out menu list. This will activate the Add Label window.
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Set Type Well Curve
Mapped Offset
Add Segment

Set Reference Point
Edit Reference Offset Fed Sky Bazal Shale

™ Top O Base

Delete Reference Point
Add Zone h
Delete Zone

Show All Cancel ! ] K l

General Properties

21. Type in a Red Sky Basal Shale in the field provided.
22. Click on the button. This will close the window and add the Red Sky Basal Shale Zone Label
to the Type Well pane.

The zone labels will be added to the Well Path Pane after you put in a reference point and then add the
first segment.

CA Fle Edit View Help

Well Path (Vertical Section)

210 220 230 240 250 260 270 280 290 300 310 320 330 340 350 360 270 [0 90 400 410 420 430 440 450 J60 470 480 B0 SO0 510 520 530 540 S50
€ > |« >
Weell Path: VS 533,41, MD 226693, TVD 245591 I/ Out: 0.00/0.00 (-1.00%) Dig": 91.00 | Azimuthe 110.00 Strike: 315,00 &u‘: 0.50
e TE T ~—cm SS— Y TN LTI T e

Zones Display Properties
1. Right Click anywhere in either pane to activate the pop out menu.
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- B Add Segment Curve Settings | Fornations | Zones | Screen Formet |
Set Type Well Curve Tt Seqmcnt ; =] ™ lgnore NULL
Mapped Offset Change Azimuth o a
Add Segment Set Well Path L] — Left/Bim: [°
Set Reference Paint Set Gamma Right/Tap-: ID
Edit Reference Offset [ [ tne Sz [ -Gid
Delete Reference Point (remest hioperte: Line Style: !D Major ]1
A Fars Ll General Properties [} | " ]—'1
Deliete Zone Show/Hide Tops
Show/Hide Zones
i_ ShOW ;\” . i Show,/Hide Peforations
. _m%nera[ Properties PN _' Show/Hide Zone Fill

2. Select General Properties. This will activate the General Properties window.

3.

Click on the Zones Tab to activate the Zones display properties.

Note: Zones will only appear in this list if they been entered in the Type Well Portion (left side) of the
Geo*Steer application.

4. Click on the drop arrow and select the zone you wish to change the display for.

You can change the display name if you wish by typing in a new Zone name. These can be tops or any
other indicators you wish to display in the Well Path Section of the Geo*Steer application.

9.

Curve Seﬂings] Formations ~ Zones l Screen Format ]

Red Sky Basal Shale = Color Badteglces:
! = o] 2- HrEECENER
Ted e s ECFETEEN
[Red Sky Basal Shale oSy ® EEEENENN
|| HEEN
Type Well Depth [2435.5 ™ Top  Base Reset EriEEEEN
HEEENTE

Custom calors:
i iR
5 | O
Define Custom Colors > ‘

oK Cancel |

If you wish to change the color of the Zone line then you can click on the %i B putton to
activate the Color pallet. Select a new color and then click on the button.

Line Size portion of the window will change the line thickness from 1 to 9 (pixels wide). You
have to type a number in the size field and your input will be automatically displayed by the
curve.

Line Style portion of the window will change the line style. You have to type a number in the
style field from 0 to 3 and your input will be automatically displayed by the curve. 0=Solid line,
1=Dashed Line, 2=Dotted Line, 3=Dash Dot Line.

If you choose to change the Type Well depth and or the @ Top @ Base gase or Top of zone

then you must click on the L’”fﬂ button
Repeat steps 4-8 for changes to other zone lines.

10. Click on the “ in the upper right hand corner to exit this window.
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Set Reference Point

First thing you have to do is set up a reference point. You will need to know the general strike and dip of
the formation you wish to steer this well for and the depth offset so that you can move the steered
wells curve data up or down to match near the zone of interest. This offset is critical for display
purposes and should be correlated to the last Formation top encountered before the zone of interest
to be drilled along is encountered. This can be changed after the fact but will affect the segments that
have been manipulated if done after the fact. The Strike and Dip will not be allowed to change. If you do
want to change the strike and dip then you will have to delete the Reference point and that will delete
all the segments that have been entered so you will be starting anew.

So it is quite important not to set up this reference point too soon as the segment manipulation is quite
dependent on dip and if your well bore is less than 80 degrees inclination then you are manipulating bed
thickness and not bedding dip, azimuth and or faulting.

1. Right Click on the Type Well Pane at 2360 which is a little above the depth that we wish to start our
correlations and select Set Reference Point from the pop out menu. This will activate the Reference
Point window.

Set Type Well Curve | Reference Point
Mapped Offset |
Add Segment

Set Reference Point MD Depth WS Depth Dip Azimith
Edit Reference Offset =
451392637 [229.89615, |1 |315

Delete Reference Point
Add Zone

Type \Well Offset (TVD] |5
Delete Zone

Show Al . | Ok Cancel I

General Properties

Note: The Reference Points Dip and Azimuth refers to the regional Strike and Dip in the area for your
drilled zone of interest. The Type Well Offset moves your steered well up or down to match with the
Type well. A negative number will move your steered well being drilled up and a positive number in this
field will move your correlatable well down. This offset and steering should really be done when you are
near your zone of interest.

2. Inthe Reference Point window the default Dip and Azimuth are OK for this tutorial. Normally the
user will fill in the Regional strike and dip. The defaults are (1 degree) and strike azimuth (315
degrees) for our intended formation or zone you wish to steer.

3. Tab key to advance and highlight to the Type Well Offset field and type -0.5 in the Type well offset.

4. Click on the L_%_|button. Once the reference point has been set you will see a pink line in both
the Type Well and your correlating well as shown above

Power*Steer Tutorial Page 20




Power*Steer Tutorial POWE@:“%UITE“2016

P x|

‘Well Path (Vertical Section)
of T 1 1 T | 150 2417

5 TH
B _','M-;”'*“\k"‘.‘u.ull T i 7
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230 240 250 260 270 2B0 290 300 310 320 330 340 350 360 370 IL0 390 S00 210 470 430 430 250 460 470 480 490 500 510 520 530 540 56

— I

€ > < »
Well Path: VS 457.28, MD 278116, TVD 245590 ey Qe 0,00/0,00 [-1.87%) Dip™ 100 Azimwthe 110.00 Strike: 31500 Offset: -0.50
e———— = r—— Forow, —————

Segments

This is the nuts and bolts of the Power*Steer application and we should spend some time explaining
what a segment does for you. A segment consists of various integral pieces of data that has Vertical
Section depths from and to, Measured Depths from and to, True Vertical Depths from and to along with
Dip angle, Azimuths and throws. All the Segment data is manipulated on the type well by shrinking and
extending the VS start and VS end points, moving the entire segment to create a throw (indicated by a
fault on the Well Path Pane) or changing the Segment Azimuth.

Segment Definition

A segment is a depth range on the Gamma Ray trace (either MD or VS depth range) that is then
converted to TVD depth on the Trace Well. To select a segment you will have to click on the segment
marker (arbitrary color) which is defined below the Vertical Section / Measured Depth Gamma Ray trace
from the active well. Once the segment is clicked on you will see the Steered Well Gamma Ray curve
(turns red) to make it active on the Type well and it will have a VS start line and VS finish line on both
the Type Well and Well Path Panes. The Gamma Ray trace may go down or up or both depending on the
well path over the segment interval. The segment trace on the Type well will appear red when going
down and black when going up.

Add the first Segment
(First one is different than all the rest) The top of this segment cannot be
refined with a change of dip or azimuth. It is just a starting point. The rest of

Set Type Well Curve
Mapped Offset
Add Segment

the segments after the first can be redefined on both the VS Start and VS End Set Reference Paint
or create some faulting. | Edit Reference Offset
Delete Reference Point
1. Right Click @ 2362 (somewhere near but deeper than your reference | AddZone
point) and Select Add Segment from the pop out menu. it |
Show All

General Properties
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The first segments Gamma Ray data will be displayed on your Type Well as a red curve and will be
placed at the offset depth that was entered into your Set Reference Point. The display depths for the
Gamma Ray curve on the Type Well pane have been recalculated from its Measured Depth / Vertical
Section Depths to True Vertical Depth so the user can attempt to correlate to the type Well. The first
segment will extend to the end depth of your current Survey data and will omit any Gamma Ray Curve
data beyond that as it does not have any TVD depths associated to represent that data.

Note: You can only manipulate the bottom of this first segment (VS End).

Adding more Segments.

1. Right Click @ 235 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the pop
out menu.

2. Right Click @ 240 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the pop
out menu.

3. Click on the segment just created from 235 to 240 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end

indicators.
" = N
[E3 File Edit View Help Window - [&] %
b2 té
* *
o 7y 1 150 ] 1
o i
R m
i j*' -
237 > H
A ?
2 i 210 320 330 340 250
b
4 fe, A
230 R L fAN L Y RUN
T P AT
4
b =
f 310 320 330 240 290

<
Well Path: VS 237.97, MD 2508.16, TVD 245320 In/Out: 0.00/D,00 (-1:#1%) Dip*: 100 Azimuth: 110.00 Strike: 315.00 [Offset: -0.50

Changing the bedding angle of a Segment
1. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
2. If you were to move the mouse pointer to hover over the VS End marker (blue line above and

right) the cursor will turn into a I as shown above.
3. Click and drag the VS End down to match the GR peak in the type well. This will change the
bedding angle from 0.42 to approximately 7.33 degrees.
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Y T = ® T

)

250 260 270 280

>
Well Path: VS 235,50, MD 2504.32 TVD 2450.91 In/Qut: 0.00/0,00 (-1#/%) Dip*: 100 |Azimuth: 110.00 [Strike: 315.00 [Offset: -0.50

Extending the Segment

1.

Then hold the Shift key down and roll the scroll button on your mouse towards you and stop
when it gets to 2369. This is where the GR Segment changes and does not perfectly match the
Type well.

You can also hold the Shift key down and Mouse over the end of the segment on the Well Path
pane and when it turns into an ++* arrow click and drag left or right to shrink or extend the
segment.

You will want to double click on the Red Segment from 235-242.6 and this will keep the
segment visible on the Type Well after you initiate the next segment.

Adding another Segment

1.

Right Click @ 253 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.

Click on the segment just created from 244.5 to 253 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators.
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3 Fle Edit View Help Window
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (purple line above and

right) the cursor will turn into a I as shown above.

4. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.34 to approximately -2.65 degrees.

5. You will want to double click on the Red Segment from 244.5-253 and this will keep the
segment visible on the Type Well after you initiate the next segment.

[ file £t View Help Window _imx

Do ea

Well Fath (Vertical Section)

3

Well Path: VS 25135, MD 252888, TVD 248600 In/Out: LOMGI0 [-151%) Dip® 100 (it 100,00 Strike: 31500 [Offet: -050
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Adding another Segment
3. Right Click @ 300 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
4. Click on the segment just created from 253 to 300 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.

File Edit View Help Window

Well Fath (Vertical Section)

730 240 250 760 Fili) 280 260 ETiTi]
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Changing the bedding angle of a Segment
6. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
7. If you were to move the mouse pointer to hover over the VS End marker (greed line above and

right) the cursor will turn into a I as shown above.

6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.39 to approximately 0.11 degrees.

7. You will want to double click on the Red Segment from 252-300 and this will keep the segment
visible on the Type Well after you initiate the next segment.
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Adding another Segment

1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.

2. Right Click @ 350 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.

3. Click on the segment just created from 300 to 350 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.

CA Fle Edit View Help Window
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (purple line above and

right) the cursor will turn into a I as shown above.
6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.41 to approximately -0.04 degrees.

Extending the Segment
1. Then hold the Shift key down and roll the scroll button on your mouse towards you and stop
when it gets to 2424.5. This is where the GR Segment changes and gets a little off below this
depth.
2. You can also hold the Shift key down and Mouse over the end of the segment on the Well Path
pane and when it turns into an +* arrow click and drag to the right to extend the segment to
493 Vertical Section.

3. You will want to double click on the Red Segment from 300-493 and this will keep the segment
visible on the Type Well after you initiate the next segment.

[A Fie Edit View Help Window
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Adding another Segment

1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.

2. Right Click @ 520 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.

3. Click on the segment just created from 493 to 520 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (purple line above and

right) the cursor will turn into a I up/down arrow.

6. Click and drag the VS End down to match the GR peak in the type well. This will change the
bedding angle from 0.59 to approximately 1.11 degrees.

7. You will want to double click on the Red Segment from 493 to 520 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.

Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. Right Click @ 565 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
3. Click on the segment just created from 520 to 565 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (blue line above and

right) the cursor will turn into a I up/down arrow.

6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.04 to approximately -0.59 degrees.

8. You will want to double click on the Red Segment from 520 to 565 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Adding another Segment

1.
2.

Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
Right Click @ 700 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.

Click on the segment just created from 565 to 700 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.

Waell Fath (Vertical Section)

Well Path: V5 SET.84, MO 250182 TVD 245071 In/ws 0.00/0.00 -181%) Dip’s 100 [Agimuth: 11000 [Sarike: §15.00 (Cfset: -0.50
— T — - S—— Y YT Y I ——

Changing the bedding angle of a Segment

1.

Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
If you were to move the mouse pointer to hover over the VS End marker (blue line above and

right) the cursor will turn into a I up/down arrow.

Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.55 to approximately 0.59 degrees.

You will want to double click on the Red Segment from 565 to 700 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Adding another Segment
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1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.

2.

You will now want to expand the Type Well Scale by Clicking on this pane and holding the CTRL

Key down and rolling the roller ball on your mouse away from you to increase the scale.

pop out menu.

Right Click @ 806 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the

Click on the segment just created from 700 to 806 VS to highlight the Gamma Ray section (Red

(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end

indicators.
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Changing the bedding angle of a Segment
1.

RSD Curve (Type Well) : RSD (TVD) Depth 2432.25, MD Depth -1.00, Value 11232
[ et e R S e VLS S

2428

2424,

2432

Click once on the Segment Marker below the Gamma Ray curve (shown on previous page) to
highlight the segment on the Type Well.
If you were to move the mouse pointer to hover over the VS End marker (blue line above and

right) the cursor will turn into a I up/down arrow.

Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.52 to approximately 0.76 degrees.

You will want to double click on the Red Segment from 700 to 806 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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The Last Segment
1.
2.

Scroll right (deeper) on the Well Path pane.

Click on the segment from 806 to 907 VS to highlight the Gamma Ray section (Red (Well bore
heading down) / Black (Well Bore heading up) and you will see VS Start and VS end indicators.
As far As | can tell they are lined up over each other so you are now done with the Power*Steer
portion of the tutorial.
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Zone Fills Dot segmet
Change Azimuth
The zone fills option adds some color to the final product. Set Well Path
Set Gamma
1. Right Click on the Well Path / GR Panes to activate the pop out menu. il W
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Calculate In / Out

This menu selection works with the zones that were added and where the zones were indicated as the
top and base. When those are defined the user can select this Edit menu selection and it will calculate
the amount of well path that is in the zone and the amount of well path that is out of the zone. This
calculation is started when the well path first encounters the top of your zone of interest.

General ES

1. Click on the Edit Menu to activate the drop down list
and select Calculate In / Out.

Curve Settings | Formations  Zones I Sereen Format |

Z0l - Color |
This will be printed in the output as well as displayed in the e Line Size: |2
Status bar when your mouse pointer is focused in the Well [ Line Stje: [°
Path portion of the window. Type Wel Depth |2429 @ Top ( Base Reset

| Edit | View Help Window

Redo Update Segment
Undo Delete Segment

Calculate In / Out ]:? .

Well Path: W5 567.91, MD 2801.72, TVD 241941 In/Out: 322.46/0.00 (100.00%)

Print
1. Click on the File Menu to activate the drop down list. e
2. Click on Print selection or click on the | Print button on the Toolbar Ml
to activate the Print Options window shown below. tiackgarit Graghic ’
Import »
3. VS /MD Range portion of the window indicates the Vertical Section Ex:m ,
depth range or Measured Depth Range you wish to print. Type in the [ pane. [y CHeP '
depth range in the fields provided. e
(Your Power*Steer application may be in Measured Depth [MD Range] units.) Bit
4. Well Path Scale portion of the window indicates the —
Print Options

TVD depth range you wish to print. Type in the TVD
depth range in the fields provided. \[;%:ai o oo Loge

5. Type Well Width field is how wide you want to print e TRIVEGNBMF .. |
this portion of the Power*Steer window. Type in a Tom [P0 pa PR | DM

|—Somewhere Close

width in Inches in the field. ossrens |
The depth scale interval and scale of the Type well will be i il

. . . Fi.\/. [Bob] Sephton
determined by what is viewed on your screen and the paper &
size an orientation. p:': -

6. Border field is how much border you wish to have Piesewp | [FimPae ]
around the top, bottom, and left edges of your '
print. Type in a border width in inches in the field. _ _ sl |

7. Print field drop box is the VS Depth Scale of your
print. Click on the drop box and select from the List or the user can also Type a VS depth scale
in the field.

8. Click on the Service Company logo = button to search your computer for a logo to put in your
header.

9. Type in the Type Well Name / Location is the Type Well field. Depress the tab key on your
keypad to advance the cursor to the Interpreter field.

Power*Steer Tutorial Page 34



Power*Steer Tutorial POWE@}%UITE“2016

10. Type in the Interpreters name who created the interpretation in the Interpreter field.
@ button allows the user to setup the printer for the Power*Steer output
11. When you are ready to print your Power*Steer log, click on the button.
Power*Curve / Power*Steer display
This is another way to display the lithology in the Power*Curve module in the detailed lithology track of

our default logs. The normal curve fill would be the well path but we will now show you a Power*Steer
curve fill layer.

Connecting to the Database

-
o
PowerCurve

1.) Double click on the 201 Icon. Acknowledge the Security Information window by clicking on the
button. This will initiate the program and activate a Connect Database window.

| Connect Database
| Databases:
PGEOLOGY 2016 IMPE [Microsoft &ccess T a
o)
User (D: |Paselooy Cannect
Password; | Cancel

2.) Highlight the PGEOLOGY 2016 METRIC (Microsoft Access Driver[*.mbd])) database by clicking on it once.
3.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field.
Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field.

4.) Type “pgeology” in the Password field and then click on the button. The program will now load
various dictionaries and then activate an Open Log window.
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Most Becently Opered Logs
H Tutorial el Horz Log

W Tutorial Well Fiald Muote: ‘wildzards : % = any range, _ = single character

~ Search Wells by Field or DLSNTS

Choogze field to search

‘el Name | U | Spud Date [ |
i T il el 100143206323W600 Jan 3. 2015

Erter Search String

=

-DLS [Dominion Land Surveyp Spstem]

Survey
System Loc Ex LS50 Sec, Township Range EAW Mer 044 ES.

] I o

~MNTS [Mational Topagraphic Seres Spster)

Survey - :
Systern Loz Ex 14 Unit Black P, Guad L Quad. Sisteeath EiS:

< | T O

Available Logs Search | ™ ByField (" ByDLS/NTS  Clear Queny | |
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Cancel |

5.) Select the Tutorial Well from the List and then click on the button. This will open your
Tutorial Well Horz Log.
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6.) Click on the Detailed lithology track once to highlight the track in green.
7.) Click on the layer Selection list and click on or select the Curve fill layer. This will make active the

Curve fill layer.

8.) Double click anywhere within the Curve Fill layer to activate the Curve Fill Options window. This will activate
the Choose Curve Editor shown below.
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r A}

Curve: Fil Dptiﬁs_' well Path Optians

Cancel

Curve: Fill Opti
9.) Click on the Mtg-l button to activate the Curve Fill Options window.

=

Curve fills List | 1D }2 New Curve fil Curve fills List | 1D }2 New Curve fil
| Set Main Curve I | Set SecondaryCurva.! | Set Mair Curve I | Set SecondaryCurva.!
wel Path [TVD] Wwell Path (TVD) whell Path [TVD) Wwell Path [TVD)

Example Example

- Curve Optior: - Curve Optior:

Pattam Type Pattam Type

FraP = Lea FraP = Lea

Gnd Type Gnd Type

Linear - Linear -
- Fill Oiption - Fill Oiption

Fill Modes - 2 Curves Fill Modes - 1 Curve Fil Modes - 2 Curves Fill Modes - 1 Curve

| x| [wellPath |

~'Well Path Options - widthe i-‘—

:rT ™o ssL! T T —

Fill Patterns: Fill Patterns:

[Interprated Lithalogy -] [Interprated Lithalogy -]

Foreground colar Background color Foreground colar Background color

[plsck. x| bk | g [plsck. x| bk |

Solid ook Fil T Fill Medes - 1 Curve Solid ook Fil

| 3 wes | || o =1 Il 3

Fill from alue to Curve ~
I Fill from Curve toalue
Well Fath

10.) Click on the Fill Modes — 1 Curve drop box and Select Power*Steer.

11.)Click on the ﬂ button in the Curve fill Options window. The window will close and the changes you have made
will be reflected on the layer.
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For Help, press F1 ﬁuw UPDATE KB: 249

This concludes your Power*Steer Tutorial.
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